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Change Log

Date Description Author

4/16/12 More cabling instructions S. Maher

4/19/12 Updated tower schematic, info on Mac,
other small changes

S.Maher

4/21/12 Updated with new GUI screens,
auto-relock functionality

S. Maher

4/23/12 Updated wiring diagram with
opto-isolator, updated block diagram,
added text on thermometry computer
and new features of Nexus

S. Maher

10/26/12 Comments on Detector computer
startup, startup checklist, NTP
comments, Nexus maintenance

S. Maher

4/11/13 Updated and moved startup list, added
CRUSH upgrade and reprocess
information; added text to thermometry
alarm section; added more details
about IRIG cabling

S. Maher

5/3/13 Commanding Detector Bias, reprocessing
pipeline, IDL use, Java upgrades, temp
alarm waits for two occurrences,
CRUSH pause and scan project
ownership modification

S. Maher
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Quickstart Checklist
This is a checklist for connecting and starting the electronics and computers.  Note, there are
more details and pictures in other parts of this document.

1. Connect thermometry cables to dewar
2. Connect dewar power cable from GISMO power box to crate
3. Connect tower power cable from tower to crate (has DB connector)
4. Make sure power switches on tower and crate are turned off
5. Connect fibers to crate and tower.  Feed tower fibers up through hole in plate on top of

crate.  Two of the SMB cables (labelled D0+ and D0- with paper) remain disconnected.
6. Tape tower fiber to top of tower to prevent disconnect
7. Connect BNC cable labelled “Gold Filter #9 IRIG” to connector 9 on front of gold box

(“Clean” side) under computer in GISMO electronics rack.  (The other end should
connect to the small (5x5x2 cm) green BNC->SMB(x2) box connected to the crate.

8. Connect long black ethernet cable in back of GISMO electronics rack (with “GISMO”
label) to IRAM network switch (Note, for April 2013 switch we used the “GISMO”
network switch but also made an ethernet connection to the “normal” network switch in
order to access the internet.

9. Connect IRAM IRIG BNC cable to BNC cable in back of GISMO electronics rack that is
labelled “IRAM IRIG B” - it is connected to the back of the PC.  The IRAM IRIG BNC cable
is a pink BNC cable that is usually located under the M3/M4? arm (near NIKA) under the
floor tile with the circular cable port

10. Connect ethernet, and USB cables from GISMO electronics rack to Mac.  These cables
are usually kept bundled together in the back

11. Connect keyboard, mouse, and monitor (use VGA connection) to GISMO electronics rack
computer (the server)

12. WARNING: Do NOT power on the crate or tower while cooling down GISMO! (This
will cause trapped flux).  Turn off the power switches on the crate and tower
before proceeding.

13. Locate white, American power strip with “110V” written on it
14. Connect the following to the 110V power strip

a. power cable from GISMO electronics rack
b. power cable from GISMO power box
c. Mac power cable
d. PC computer monitor power cable

15. Connect 110V power strip to 220V/110V transformer.  Make sure the power strip is
turned off.

16. Connect 220v-110v transformer to IRAM power.  Make sure the ground IS
CONNECTED (i.e., do not put in a ground breaker), otherwise GISMO will
experience additional noise

17. Turn on 110V power strip - light should shine
18. If necessary, turn on GISMO power box power strip (red button on power strip mounted

to box)
19. If necessary, turn on GISMO electronics rack power strip (red button on power strip

mounted to box)
20. If not cooling down, turn on the crate - to test the settings on the powerbox.  If there

are any red lights, refer to the troubleshooting section of this document
21. Turn off the crate
22. Power on the Mac (button on back of monitor on the bottom-left) and login (password

on tape on front)
23. On the Mac start a web browser (Safari) on the Mac to verify network connectivity.
24. On the Mac start GISMO Labview program (currently “GismoV2 alias” on the desktop).

Double click on it and click on the “run” arrow.  (Note, this will start sending
thermometry information to the GISMO Nexus and may start alarm sounds in the
operations room)

25. Make sure the switch on the power supply on the back of the PC is on.
26. Turn on the PC monitor
27. Open the front of the PC and depress the large rocker switch until the lights come on
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(about one second)
28. On the PC the BIOS will complain about settings.  Press the key to edit settings (F1).

When the BIOS editor appears, press ESC and exit the editor (accepting “Y” to discard
changes).  The computer will continue to boot.

29. Note, the GISMO server software starts automatically, you do not need to run
anything.

30. After the PC boots, run Applications > Internet > Mozilla Firefox and see if the home
page (Google) loads.  Usually after a cold boot the networking doesn’t work.

31. If the networking doesn’t work: open a terminal and type ‘sudo halt’.  After halting,
depress smaller rocker switch on front of PC.  Repeat BIOS editting and let reboot.
Repeat networking test.  If fails again, then repeat the procedure.

32. That completes the work in the receiver cabin
33. Log into mrt-lx1 as user t16 (loja1305)
34. Change directories to /usr/local/gismo.
35. If appropriate, run “./archive.sh” to archive the contents of the GISMO Nexus

(including all the GISMO pipeline code such as the IDL merge code)
36. Run “./cleanAll.sh” to reset the GISMO Nexus and logs for a new project/pool.  Make

sure you want to do this as this will remove all the Nexus content!
37. Run “./cronJobs.sh” to initialize the required cron jobs for the GISMO backend
38. Open a web browser to the GISMO Nexus (https://mrt-lx1.iram.es/Devices/GISMO/) and

verify it loads and doesn’t have old data.
39. Edit file /usr/local/gismo/iramintegration/bin/postProcess.sh.  Around line 193,

update the “destDir” variable (if needed) to point to the current “GISMO” account
directory - for example,
/mrt­lx3/vis/gismo12/observationData/gismo/$source/$sid.  Don’t forget to
retain the $source and $sid variables.  The file is read-only so you will need to deal with
that when editing and should return it to read-only.

40. In the control room connect the GISMO client to power, keyboard, mouse, monitors, and
ethernet.  Power on the computer.

41. Double click on the “Run GISMO” icon on the desktop
42. Run the tuner (Tuning Tab > Start Tuning)
43. GISMO is now ready to observe.  Initiate observations with Pako
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Introduction
This document describes the architecture and operation of the Goddard-IRAM
Super-conducting 2-Millimeter Observer (GISMO) software ingest system.  This document does
not describe details of the CRUSH data reduction software, since the documentation is
included in the tarball that can be downloaded from:
http://www.submm.caltech.edu/~sharc/crush/.  For information about the specific pieces of
IRAM data that are  used by the GISMO system, refer to the GISMO NCS Interface document.

Please feel free to provide comments or questions to stephen.f.maher@nasa.gov.

Principle of Operation

The GISMO ingest system is designed to be simple to operate and as automated as possible.
After tuning the GISMO detector (a one-button procedure), the ingest system operates without
human intervention, producing FITS files, quick-look images, and pointing information for each
observation. Operators still prepare and initiate observations with IRAM's Pako system, but the
GISMO system automatically detects the starting and stopping of observations and uses this
information to control the processing flow and data reduction pipeline.

Calibrations (e.g., skydips, shuttered LED) are handled automatically and the operator can
control which calibrations are performed.  (Note, the CRUSH data reduction software has
essentially made calibration procedures unnecessary).

GISMO Development Wiki

A primitive wiki was used during the development of GISMO. It mostly contains internal notes
and much of it is outdated and not well organized, however, there is some good reference
material and this document will sometimes reference the wiki for more detail.  It should be
noted that the wiki runs on the GISMO Detector computer and care should be taken so as to
not impact the performance of observations by stressing the wiki too much. The wiki URL
http://gismo­detector.iram.es:8080/JSPWiki/.

Architecture Overview
The GISMO ingest system consists of several computers working in tandem.  The Detector
computer receives and decodes the detector readings and commands the detector electronics.
 The Control computer lets the operator monitor the GISMO system, perform automatic tuning,
and change calibration procedures.  It also archives the raw data to disk.  The Merge computer
takes the raw data, and merges it with the telescope astrometry to create GISMO merge files.
The Merge computer also reduces the data using the CRUSH data reduction software to create
a “quicklook” image and automated log entries that are posted on an IRAM website called the
GISMO Nexus.  Typically, more thorough data reduction is subsequently performed using CRUSH
on one or more of the GISMO merge files.
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GISMO Ingest Architecture

Detector Computer

The Detector computer is dedicated to reading the detector data and housekeeping and sending
the data to the Control computer.  It also sends all commands to the electronics and runs the
tuning algorithm and IV curves when requested.  The software is written in Java and the
operating system is Debian Linux.

Control Computer

The Control computer manages the ingest process.  The software is Java and runs on Windows
XP.  The choice of Windows is because the system requires National Instruments drivers and
those aren’t well supported on Linux.

The Control computer does the following for ingest:
● Receives the data from the Detector computer
● Listens to IRAM Elvin messages which tells the Control computer when scans occur and

thus when to archive
● Moves the data to the Merge computer when a scan is complete
● Commands the National Instruments flipper controllers to move neutral density filters into

and out of the beam (this is done rarely)

Note, the Control computer has two RAID 1 (mirroring) disk volumes; one for the system and
one for the data archives. 

The Control computer also provides users with various functions
● Allows users to initiate auto-tuning
● Allows users to see realtime plots of data
● Allows users to modify calibration options
● Allows users to set optical filter positions
● Allows users to run diagnostics such as I(V) curves
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Merge Computer

The Merge computer takes the detector data and merges it with the IRAM telescope astrometry
data. It also runs the CRUSH data reduction software to create a map of the scan using default
parameters as well as diagnostic information about the reduction (pointing information, noise
levels, etc).  This is refered to as “quick look” information and provides quick diagnostics to the
astronomer.   Starting with the fifth GISMO run, the merge software runs on an IRAM computer
(mrt-lx1).  The software for the merge is written in IDL and shell scripts.

More specifically, the Merge computer does the following:
1. Receives data from the Control computer and queues the data for processing
2. If scan was a skydip, perform tau reduction
3. Retrieves the appropriate IRAM astrometry file(s)
4. Merge astrometry with detector data using cubic interpolation (the two data sources are

synchronized using IRIG timestamps)
5. Copy resulting merged file, original detector files, IRAM astrometry files, ancillary files

such is IV curves and skydip results to an archive
6. Run the CRUSH data reduction software and archive the results
7. Publish the CRUSH quicklook images and reduction summary (e.g., pointing information)

(also known as the GISMO “log”)  to a webserver running on the Merge computer.   The
URL for the website is https://mrt-lx1.iram.es/Devices/GISMO/

8. Provide an audio queue to the operator that the GISMO data processing has completed
9. Receive GISMO dewar temperature readings from the GISMO Mac for display and alarming
10. Allow the user to add entries to the GISMO log using a web page

9

https://www.google.com/url?q=https%3A%2F%2Fmrt-lx1.iram.es%2FDevices%2FGISMO%2F&sa=D&sntz=1&usg=AFQjCNGPIBdU1CtY2C8tcESzveIssKO3cQ


User Interaction
The GISMO system requires very little user intervention.  Astronomers command Pako to observe
sources and GISMO data files, logs, and “quicklook” display are automatically produced.

Administrators, however, need to be able to understand how to start the system and perhaps
run various diagnostics.

The first section below presents the normal steps required to run the GISMO system
(“Operator”).  The second section presents functions more appropriate for an “Administrator”.

Operator Interaction

Detector Computer
No interaction is required.

Control Computer

Once the GISMO system is powered up, the operator needs to start and tune the system.
Then no interaction is required (although monitoring is recommended).

Start Acquisition System

To start the system, go to the Configuration tab on the GISMO Console and click the Start
System button.  After a few moments, the GISMO Server entry under the Connections section
should turn green and the Frames/sec entry should display roughly 10,000 after things settle
down.  Note, the IRAM Elvin indicator indicates a successful receipt of IRAM Elvin messages and
should be green.
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Starting the GISMO acquisition system

Tune

The system needs to be tuned after an initial cool-down or a power cycle.  Tuning has shown
to be stable and does not need to be performed after cycling the dewar.  Tuning automatically
selects optimum SQUID parameters.  To run the tuning, click the Start Tuning button on the
Tuning tab, as shown below.  The Tuning indicator near the top of the window will show the
progress of the tuning.  The complete tuning cycle takes approximately ten minutes.
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Merge Computer

Below are samples of the quicklook images and reduction summary that are available to GISMO
operators within a minute or two after an observation.  The page also includes project
observation times, pixel status display, and select GISMO temperatures (with alarm indicators).
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The URL is https://mrt-lx1.iram.es/Devices/GISMO/.

GISMO Nexus  Main Page
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GISMO Nexus Log Page
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GISMO Nexus “Make Log Entry” page

Administrator Interaction

Detector Computer

Typically very little interaction occurs on the Detector Computer.  Administrators may use the
interface on the Detector Computer for more advanced functionality (e.g., change the
auto-tune parameters, run a ramp against one of the SQUID stages).  Working with this
advanced functionality is beyond the scope of this document.

Control Computer

Main Window

The following is the main GISMO Control window.
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The top half provides status information and the bottom half has tabs to reach more detailed
information and functionality.

The status at the top includes
● Whether "Archiving" is occurring and if so, details about the source and archive duration
● Whether the system is currently "Tuning"
● Whether the system is "Genarating IV Curves"
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● Whether a feedback relock is being performed
● Whether an acceptable number of pixels are operating within specification and also a

detailed plot of the pixel status

Plots Tab

The plots tab is used to open XY line plots of the SAE and DAC values ("Show SAE Plot" and
"Show DAC plot").  These are actually 3D graphics windows that extend pixels down the Z axis.
 Use all mouse functions (including wheel) to manipulate the plots) Press 'h' on the plot window
for some help.

"Show DAC Twinkle" opens a "twinkle" chart of the DAC values.  Optionally pressing the "Perform
DAC Normalization" will average the DAC values for a few seconds and then subtract the
average from subsequent data.

Also available (but not pictured in the image) are twinkle charts that automatically remove noise
from the pixel values.

Note: when operating in closed loop (which is the nominal state of the data acquisition), “DAC”
is the linearized detector signal, and “SAE” is the error signal (Scaled Accumulated Error).

Tuning Tab
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The Tuning tab lets an operator run the auto-tuner.  The auto-tuner will tune the bias and
feedback values for the SQUID multiplexers and the SQUID series arrays.  Some detailed
information about the tuning can be seen when "Show tuning logs" is pressed.  The tuning may
be aborted but then the biases and feedbacks will most likely not be in an optimal state, or
worse.  An advanced option allows for a shorter tuning cycle, but this is not recommended.
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Example tuning log contents

Configuration Tab

This tab is used to start the system after power up, set the detector biases, and relock the
detector’s feedback mechanism.
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The configuration tab is used for the following:
● Start, stop, and set the rate of the readout electronics
● Set the default DAC value used for relocking
● Relock the detectors
● Set the detector biases

Setting the default DAC and Detector Bias values in this interface will immediately command the
values on the Detector computer.

Values that are set are saved in a file and will be remembered.

If an incorrect value is entered, a message will appear, the field in question will change
appearance, and the operator must correct the value (and press "Enter") before proceeding.

The Advanced option of “Automatically relock detectors before each scan” is a little mislabled.
It arms an automatic relock when there is a large (3 degree) elevation shift between scans.
Then when the the telescope is within two degrees of the next source, the relock is executed.
If successive scans don’t deviate by more than three degrees, no relock will be performed.  The
operation is needed because changing sky loads (due to different elevations) can cause the
detectors to lose feedback lock.

IV Curves Tab

This tab is used to generate IV curves for diagnostic analysis.
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The IV Curves tab allows users to run new IV Curves as will as analyze previously run IV
Curves.      

Running IV curve

Running an IV curve is on the left side of the tab and involves setting bias parameters and
pressing "Start IV Curve".  During the curve the bias will go from "start" to "end", incrementing
at intervals of size "delta".  It will then return back to the start value, also increment by "delta".
 The curve data is only record for the "start" to "end" segment.  The data is stored in the
standard archive location (e.g., F:/).  Optionally, press "Show IV Curve plot" to see a live
output of the curve.  (It is useful to use the "flat" version of the plot - option "f").
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IV Curve Plots

IV Curve Analysis Twinkle

When an IV curve is run, the results are analyzed (fitted with hyperboli and lines) to determine
the transition point and power.  The raw data and the results are stored in files.  Optionally,
pressing "Show IV Curve analysis twinkle" before the curve is run will present a plot similar the
one below, showing transition bias, slope of normal, and absolute power.  A value of 65,565
(usually white in the plot) indicates the transition is estimated to be higher than the starting
bias of the IV curve.
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IV Curve Diagnostic Display

IV Curve Debug Plots

If "Show per-pixel analysis plots" is checked, the curves of all pixels will be displayed.
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IV Curve Diagnostic Debug Display

Calibration Tab
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The Calibration tab lets operators adjust what calibrations are automatically performed during
skydips and standard scans.  The options are saved to a file automatically. (Note that the LED
is currently not available).

Note, the calibrations described are typically not needed when using the CRUSH data reduction
system.  CRUSH retrieves TAU from IRAM systems (and also does internal calculations) and
that is sufficient.

Skydips

The operator has the option to run a single IV curve at the beginning of a slew-elevation skydip.
 Additionally the operator has the option to run a single IV curve at the beginning of each
elevation of a discrete elevation skydip.  The GISMO Ingest system automatically identifies the
various skydips and performs the requested calibration.   

Note, recently Skydips have not been needed when using CRUSH

Observing Scans

The operator can automatically run an IV curve at the beginning of a standard scan or run an
LED/Shutter calibration.  The LED/Shutter calibration closes the shutter, flashes the LED, and
opens the shutter. (Note that the LED is currently not available).

Output

There is a CALIB_FLAG in the FITS file that indicates when and what calibration was performed.
 All IV curve data is archived with the FITS files.  Skydips trigger a TAU reduction IDL program
execution whose output is included 1) with the skydip scan archive and 2) in the primary header
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of the FITS files of subsequent observing scans.

Filters Tab

Typical Use
This functionality is not needed in standard operational mode.   Two neutral density filters can
be moved in and out of the beam on this tab.  The need for these filters is TBD.

The Filter tab allows an operator to open and close the two neutral density filter flippers in
GISMO.  The system tries to remind the operator of the state of the filters, but since there are
no position sensors for the flippers, it is an estimate.

Miscellaneous Tab
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The Miscellaneous tab is a catch-all for various functions, some being obsolete.  The operator
does have the ability to manually start and stop the archiver on this tab.  This can be useful if
for some reason the GISMO Ingest system doesn't stop archiving after a scan during some
anomalous condition (e.g., IRAM computer failure).  
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Startup Warnings

There can be various warnings that can occur when starting the Control software.  This
section describes them.

Connecting to Detector Computer

Upon startup the Control computer will try to connect to the Detector computer.  The following
dialog box will appear:

This isn’t necessarily a warning, but it may take numerous attempts (1-20) to connect to the
server (the connection is a lower priority item on the Detector computer).  The connection may
be cancelled by the user by pressing the Cancel button, but this is only useful in special
situations where communication with the server is not needed, such as when you're doing
analysis of previously generated IV curves (which is not described in this document).

Simultaneous Clients

The Control computer uses a lock file to prevent multiple clients from running simultaneously.  If
you start more than one client at a time, or a client terminated prematurely (and didn't erase
the lock file), you will see the following error dialog.  If you are running only one client, select
"Yes".  Otherwise select "No"

 

Can't connect to TTL devices

NOTE: The TTL devices are no longer used but are still in the software.  Any errors can be
ignored.
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The Control computer needs to communicate with two ethernet-based National Instruments
9401 devices (http://sine.ni.com/nips/cds/view/p/lang/en/nid/208809)  to control the LED
flasher, shutter, and the filter flippers.  If the 9401’s are not available, the following error will
appear:

To diagnose connection issues with the ENET devices:
1. Try pinging the devices (IPs TBD)
2. Use the National Instruments MAX ("Measurement and Automation") software to see if the

devices are enabled and have the correct device names (TBD)

Thermometry Computer
The Thermometry computer (Mac) runs the thermometry system (monitoring, heating, and
cycling).  The monitoring software does not require interaction in general.  Important
temperature values are displayed on the GISMO Nexus.

Starting the System
See the “Quickstart” section at the beginning of this document for basic steps.  See later parts
of this document for more details on cabling.

Miscellaneous Details on Starting

Detector Computer (GISMO server in receiver cabin)

The Detector computer will automatically start the GISMO software upon bootup.  To power-up
the detector computer (which is in the large electronics box), open the front door and press the
large, rocker switch momentarily.  Of course, the power supply switch in the back needs to be
turned on.

BIOS errors

The computer must have at least a monitor connected during boot.  It is recommended to not
connect the keyboard and mouse.  On this particular computer we occasionally see the BIOS
require attention on a cold boot (i.e., after power up).  It merely requires the administrator to
enter the BIOS menu and then exit the BIOS menu without changing any parameters.  However,
if the keyboard and mouse are NOT connected, the computer boots without the BIOS message
(from our experiments).

Network not working on cold boot

Also, it has been observed that the network doesn’t work on the computer from a cold boot.
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The easiest test is to start Firefox from the Applications pulldown menu at the top of the
screen.  If Firefox fails to find the home page (Google), and the network cable is connected (a
good test is to open an internet browser on the Mac), then reboot the computer (e.g., type
“sudo halt” and press small rocker switch - “sudo reboot” does not work).  You may have to do
this a third time.  We have no idea what causes this problem but once the network is up it has
never failed on us.

Won’t start

In Oct 2012 the detector computer did not POST after 5 or 6 attempts in the receiver cabin
(where it had been stored).  I brought the computer down to the building and it booted fine.
We moved it back up to the receiver cabin and had no problems.

Detector Bias

If you restart the Detector Computer software you should re-command the Detector Bias on the
Control Computer GUI -> Configuration tab.

Control Computer (GISMO Client)

Double-click the GISMO icon on the desktop.

Merge Computer (mrt-lx1)

The Merge computer is currently mrt-lx1.  The GISMO software runs as user “t16”.

Cron jobs

As user t16, run crontab ­l.  There should be two entries.  If not, run crontab ­u t16
/usr/local/gismo/cron/gismocrontab.file

After a minute at most the GISMO watchdogs will start.  To verify, run “pgrep -l gismo” and
make sure the following are running:

1. gismoMrgChk.sh
2. gismoCrushChk.sh

Thermometry Computer (Mac in Receiver Cabin)

Monitoring

LabView

The Thermometry computer (the Mac) uses LabView for GISMO Dewar thermometry interaction.
To start the main monitoring software, double-click on the “GismoV2” link on the desktop.  When
the main “panel” opens, click the arrow on the upper left, as shown in the following image:
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Cycling
To start the cycling software, double-click on the “GISMO-Cycle.vi” on the Desktop.  The main
panel should appear.  Press on the upper left arrow to start the cycle as indicated in the image
below.  The cycle takes something like 1.5 to 2 hours [need to ask Johannes or Elmer].
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Stopping the Software and Computers
Detector Computer

When the GISMO software is running there is an “IRC” window.  Select File -> Exit (or Quit) on
this window to terminate the software.  To shutdown the computer, execute “sudo halt” in a

32



shell.  The password is the same as that used on the Control Computer.  Note, if the console for
the computer is not available, it is probably okay to execute “sudo halt” after ssh’ing remotely
and without shutting down the GISMO software.

Control Computer

When the GISMO software is running there is a small “IRC” window.  Select File -> Exit (or Quit)
on this window to terminate the software. The computer is shutdown using standard Windows
methods (e.g., through the Start menu).

Merge Computer

If it is desired to disable the GISMO merging and quicklook pipelines, perform the following steps:
1. Delete the crontab for user t16 (crontab ­u t16 ­r)
2. Kill the two processes returned by the command ps x | grep gismo.*Chk | grep ­v

grep

To reinstall the cronjobs, see the Merge Computer section of the Starting the Software section.

Temperature Computer (Mac)
1. Stop any running LabView programs (via the “stopsign” button on the upper left)
2. Exit LabView
3. Select “Shutdown” from the Apple menu

Computer Administration
Overall

All computers use ntp (server 150.214.224.192).  More information on configuration is at
http://gismo­detector.iram.es:8080/JSPWiki/Wiki.jsp?page=NTP.

Detector Computer

Overview

The Detector computer runs an older version of Debian Linux.  We are locked into this version
due to a unmaintained kernel driver for the NIST MarkIII PCI card that communicates with the
GISMO (MarkIII) acquisition electronics.  In general the system should be left “as is” and new
applications and software should not be installed.

A VNC server is running on the computer for remote access.  The address is
gismo-detector.iram.es.  The password is “gismo”.

There are currently issues with the BIOS loading (on the client computer as well).

Software Location
GISMO releases are installed in ~smaher/GismoSoftware/<release>.  The
~/Desktop/GISMO_DETECTOR script is run by the gnome startup mechanism at boot (after
autologin of smaher account).  The last line of this script indicates which version of the GISMO
software is being used.  Logs for the GISMO software are stored in the directory of the current
version of the software.  For example, if GISMO_DETECTOR points to
~smaher/GismoSoftware/3-07-12-ski, then logs are stored in
~smaher/GismoSoftware/3-07-12-ski/GISMO/gismoServerJavaLog.0.txt.  The logs are rotated
and incremented (e.g. gismoServerJavaLog.1.txt, etc.).

Disk Usage
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The detector computer does not store the GISMO data locally and thus disk usage increases
relatively slowly.  Logs from the GISMO software (and of course system logs) are probably the
biggest users of disk space.  The location of the logs is noted in the Software Location section.
Older, rotated logs can be removed from the system if needed.

Backup

Their is a backup server hard drive at the 30m (currently in blue crate in laboratory off of
control room).  This can be swapped in if the server has a disk failure.  Their is also a backup
server with an additional backup hard drive at the 30m (currently in blue crate in laboratory off
of control room).  The backup server has all the necessary hardware except the IRIG card (this
would have to be transferred from the other server).

NOTE: the backup hard drives were cloned from original server Oct 26, 2012

Control Computer

The Control Computer runs Windows XP and the smaher account has administrator privileges.
There is a cygwin installation on the system for those wanting a Unix-type command support
(e.g., ssh, grep, tail, etc.).  Windows XP is used mainly to support National Instruments drivers
(used for filter flipper controllers).

Remote Desktop Server is running for remote access (from a Windows machine).  There is also a
TightVNC server installed.

Software Location
GISMO releases are installed in C:\Documents and Settings\smaher\My Documents\GISMO
Software\.  The GISMO shortcut on the desktop will point to the current release.  The (Eclipse)
development sandbox is in C:\Documents and Settings\smaher\My Documents/Heliosworkspace.

Disk Usage
There are two RAID 1 (mirroring) disk volumes on the machine.  The system volume is one and
the F: drive is another.  All the GISMO archive data is stored in F: (in the top directory).
Besides GISMO raw files, a log of Elvin messages, tuning logs, and IV curve summaries are
stored on the F: drive.  It is expected that the data will be migrated off the F: drive for each
new project that uses GISMO.

Each RAID drive is 500GB.  If a volume has a drive failure, a new 500 GB drive needs to be
installed.  The Intel Matrix Storage software the Control Computer (Windows) will help identify
the drive.

NTP

After powerup, the control computer seems to take a long time for NTP syncing.  (Note, NTP
synchronization on this computer is not critical).  To manually resync ntp, run w32tm /resync
on the command line (either MSDOS or cygwin).

No Java Upgrades

DO NOT UPGRADE JAVA!  The GISMO Client must use the same (roughly) version of Java as the
GISMO Server because Java objects are serialized and passed between them.

Merge Computer

The GISMO merge and quicklook systems are stored in mrt-lx1:/usr/local/gismo/iramintegration
and mrt-lx1:/usr/local/gismo/quicklook respectively.  One exception is the website of quicklook
which includes the contents (scripts, html, and other files) of
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mrt-lx1:/var/www/Devices/GISMO and a cgi-bin script in mrt-lx1:/usr/lib/cgi-bin/gismoLog.pl.

The merge and quicklook systems are triggered into action when files appear in special
locations.  Scripts, which are started by cron, watch for these files and when found, start
other scripts to process the data.  The crontab for both merge and quicklook are stored in
/usr/local/gismo/cron/gismocrontab.file.  Currently it is registered under the t16 user.  The
contents are as follows:

* * * * *
/usr/local/gismo/quicklook/crushAutorun/bin/gismoCrushCron.sh  >>
/usr/local/gismo/quicklook/crushAutorun/logs/gismoCrushCron.txt 2>&1
* * * * *    /usr/local/gismo/iramintegration/bin/gismoMrgCron.sh  >>
/usr/local/gismo/iramintegration/logs/gismoMrgCron.txt 2>&1

To start these cronjobs, run crontab ­u t16 /usr/local/gismo/cron/gismocrontab.file
These scripts run every minute and make sure the “watchdog” scripts are running.  If they are
not, they are started.

These scripts are run under the t16 account.

There are some README files scattered throughout /usr/local/gismo that provide more
information.

IDL License

Currently the merge software uses the ONE IDL license available at the 30m.  IF SOMEONE
USES IDL THE GISMO MERGE PROCESS WILL NOT WORK!

GISMO Nexus Reprocess

If the GISMO Nexus web page becomes corrupt for some reason, the information can be rebuilt
by doing the following:

1. As user t16 on mrt-lx1, cd into /var/www/Devices/GISMO
2. Run ./reprocess.sh

Thermometry Alarm

The Gismo Nexus includes an audible alarm in the IRAM control room when certain thermometry
readings go above certain thresholds.  The alarm is an (English) woman’s voice.  The alarm is
disabled (and enabled) on the Gismo Nexus website (https://mrt-lx1.iram.es/Devices/GISMO/).

The alarm thresholds are in /usr/local/gismo/thermo/thermoweb.py around line 19:

HE4_BATH_LIM
LN2_BATH_LIM
FST_DET_LIM
BAFFLE_TANK_LIM

In “Normal” mode, all limits are checked.  In “Cycling” mode, the first detector is ignored.  The
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software actually waits for TWO simultaneous threshold violations before alarming to filter
spurious readings.

The script to sound the alarm is in /usr/local/gismo/quicklook/crushAutorun/bin/soundAlarm.sh.

Pipeline reprocess

You may need to resubmit a GISMO “raw” file to the merge and quicklook (Nexus) pipeline.  This
can happen, for example, if the the merge process failed because IRAM FITS files weren’t
present or there were issues with the IDL license.  To reprocess GISMO data do the following:

1. Go to the directory with the data: cd ~t16/GismoData/merged/<source>/<scan>.  If
that directory doesn’t exist there were problems further upstream).

2. Execute the following commands (in this order)
a. cp *GISMO.fits /usr/local/gismo/iramintegration/incoming
b. cp *GISMO.txt /usr/local/gismo/iramintegration/incoming
c. cp *GISMO.grabme /usr/local/gismo/iramintegration/incoming

CRUSH upgrade
 Some steps probably needed if upgrading crush:

1. Install crush in directory (e.g., ~gismo-13/)
2. Update /usr/local/gismo/quicklook/crushAutorun/bin/postProcess.h line ~45 to

point to new location
3. Modify crush/wrapper.sh to use 64bit (-d64) and 8G (-Xmx8000M) and the appropriate

java (/usr/local/gismo/java/bin/java)

CRUSH (Quicklook) reprocess
To reprocess a scan in (only) the quicklook system, copy the file to the CRUSH incoming
directory and then create a notification file (a file with the same FITS file name followed by
“.grabme”:

1. t16@mrt-lx1:~/observationData/gismo/Mercury/2013-04-10.81$ cp
Mercury_2013-04-10.81_gismo.fits /usr/local/gismo/quicklook/

2. t16@mrt-lx1:~/observationData/gismo/Mercury/2013-04-10.81$ cd $_
3. t16@mrt-lx1:/usr/local/gismo/quicklook/crushAutorun/incoming$ touch

Mercury_2013-04-10.81_gismo.fits.grabme
4. Note, this will add a new entry in Nexus; it won’t replace any earlier processing of this

data.

CRUSH Pause and Project Ownership Modification

To change the project ownership of a scan:

1. touch /usr/local/gismo/quicklook/crushAutorun/incoming/PAUSE (this will PAUSE
the CRUSH pipeline)

2. wait for any current CRUSH jobs to finish
3. edit /usr/local/gismo/quicklook/crushAutorun/reduced/gismo.log and edit the

third “column” of the appropriate scans.  It’s probably a good idea to make a backup of
the log file first.

4. rm /usr/local/gismo/quicklook/crushAutorun/incoming/PAUSE (this will resume
the CRUSH pipeline)

Thermometry Computer (Mac)
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The mac runs Labview software to readout GISMO temperatures and also to run the cycling.

Software Location

The main Labview VI is “grandfinale6-ext-test.vi” on the Desktop.  Double-click on it to load
the thermometry software in Labview.  Then you must click the “run” button as shown below:

A VNC server is running on the computer for remote access.  The address is 150.214.224.247.
The password is “gismo”.  Note, the vnc connection seems to “hang” on occasion - just
restart it.

Networking

IP address info
● primary dns: 150.214.224.100
● 2nd dns: 150.214.224.54
● netmask: 255.255.255.0
● gw: 150.214.224.223
● ntp: 150.214.224.192

● gismo-detector 150.214.224.244
● gismo-control 150.214.224.246
● gismo-mac 150.214.224.247

IP addresses of the two small National Instruments TTL devices in the larger electronics box in the
receiver cabin are:

● (digitalout1) 192.168.224.80
● (digitalout2) 192.168.224.81

http://gismo­detector.iram.es:8080/JSPWiki/Wiki.jsp?page=How%20do%20I%20set%20the%20IP
%20address

The client (control) computer needs to be assigned both the gismo-control.iram.es AND
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gismo-client.local.iram.es addresses so that it can communicate on both networks. This is done on the
"Advanced" section of the TCP/IP properties. See image below for details:

Project Startup

Before a GISMO Project or Pool is started the following should be performed:

1. On the Detector computer, check the disk space.  If the disk space is getting low,
migrate off the GISMO logs and/or system logs (see Software Location in Detector
Computer section)

2. On the Control computer, migrate off the contents of the F:/ drive
3. On the Merge computer, run /usr/local/gismo/archive.sh to archive the scripts, logs and

Nexus website.  The archive is created in /usr/local/gismo.
4. Also on the Merge computer, copy the contents of /usr/local/gismo/iramintegration/logs

and /usr/local/gismo/quicklook/crushAutorun/logs and give to project.
5. On the Merge computer (mrt-lx1), run /usr/local/gismo/cleanAll.sh.  This cleans the

buffers and logs of the merging and quicklook systems and resets the GISMO Nexus for
the next project.

6. On the Merge computer, migrate the contents of ~gismo*/observationData/gismo
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GISMO Cabling

GISMO electrical and optical cabling

Grounding

IMPORTANT: All power to the electronics goes through a 110-220 volt transformer.  The 220
volt side of the transformer, which is connected to IRAM power, MUST be grounded.  Do NOT
introduce a ground breaker.

The GISMO Dewar should be electrically isolated from the stand and other metal (it
should only be grounded to the power ground).

Disconnecting (Connecting) the Dewar from the
Electronics

 This sections describes the minimal work to disconnect the electronics box from the dewar (for
example, when leaving GISMO in place and moving the electronics boxes to storage).  To reconnect,
perform the steps in reverse.  Both the Crate and Tower are located on top of the GISMO dewar.
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1) Shutdown the Detector Computer (see the section on Shutting Down Software and
Computer).  Also shutdown the Thermometry Mac (through Apple menu).

2) Turn off the Tower and Crate using the toggle switches.  See pictures of Crate power card
and Tower.  (Note the Tower and Crate can also be turned off with the computers turned on)

3) Follow instructions in the picture to disconnect the main power supplies from the smaller and
larger electronics boxes:

4) Disconnect thermometry cables as shown in the following pictures:
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5) Disconnect d0+ AND D0- SMB cables from Interface Card on top side of Crate
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Crate (interface card) showing d0+/- SMB connectors (from gismo-detector) and FR+/- and
AC+/- (to Tower)

6) Disconnect Tower serial fiber (“TWR SER”) from Tower
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Top part of the Tower showing tower serial fiber (“TWR SER”) connection (from
gismo-detector), tower power connection, and nominal light indicators (the “Data” light will flash

when data is sent [e.g., during startup or tuning])

7) Remove bottom cover of Crate

8) Unscrew and remove plate on top right of Crate (shown below).  Push rubber grommet and
fiber and SMB cables through plate.  Replace plate for easy storage.
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9) Remove fibers from bottom of Crate.  For the “CRT SER” and “MK3 CLK” fibers you must pull
the associated (Clock) card from the backplane (about two inches).  You need to loosen
screws on the top of the crate on the card and pull it out a bit.  The fibers are removed by
pulling them out.

Bottom side of Crate showing fiber connections from gismo-detector computer.  Note, the “CRT
SER” and “MK3 CLK” connections require the associated card, the “Clock” card to be pulled
out an inch or two.  The “CRT SER” connection is a little “above” the backplane and gets a

little compressed when the card is put back in position.

10) Remove fiber cable connector and power connector from side of crate.  Gently guide the
fiber heads through the opening.
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11) There is an “opto-isolator” for the IRIG-B trace signal. The isolator box is a flat,
gold-colored box.  There is also a small aluminum box velcroed to the Crate for cable breakout.
The signal that is being isolated is the “time tracer” going into the Interface Card on the crate
(d0+ and d0-).  The signal comes from the IRIG PCI card in the computer, connects to the
“Dirty Side” “Inputs” (e.g., connector number “9”) on the back of the gold isolator box.  Then
out the “Clean Side” “Outputs” (e.g., connector number “9”) on the front of the gold isolator
box and to the d0+ and d0- connections on the Crate’s Interface Card (see image in step 6).
Currently we are using a small aluminum breakout box and other small piece to convert the
BNC to dual SMB connectors (on the “-” connector both contacts are ground, on the “+”
connect both leads are positive [need to confirm].

12) At this point the electronics should be completely disconnected from the dewar.  You can
feed the cables through the floor and coil it.  NOTE, we have since added an opto-isolator to
the IRIG-B signal (a flat, gold-colored box and a small aluminum box velcroed to the Crate).
This box and cables must be disconnected as well.  It should be straightforward; all cables
can be disconnected.

13) Disconnect the IRAM IRIG cables
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Also disconnect the IRIG BNC cable (“clean” to dewar) from the front of the electronics rack
:

14) Disconnect the GISMO ethernet cable.  It’s connected to the network switch/router in the
far corner of the receiver cabin
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15) Coil all cables and stow in back of electronics box

At this point the electronics boxes are disconnect.

More Detailed Cabling Information

Inside of gismo-detector computer showing fiber connections to NIST PCI card.  The other fiber
ends connect to the bottom of the Crate

48



49



Back of gismo-detector showing three additional fibers (dsync, mk3 clk, crate serial) that
connect to the Crate and one fiber (tower serial) that connect to the Tower.  There is also an

IRIG DB9 connector that connects to the IRIG PCI card in gismo-detector.
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Tower showing SMB connections (to Crate).  Note bank of yellow “addressing” lights on the
bottom
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Crate DFB Cards showing SMB connections (to Tower)
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Schematic of SMB connections between Crate and Tower.  Also includes voltages for power
supplies.

Power Supply Settings

These pictures show the voltage settings for the Crate and Tower power supplies.
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Crate power card shown with nominal lights.  If any lights are red then try power cycling.  If
that doesn’t work then make sure the power supply voltages are set properly (see images

below.  Also refer to tower wiring schematic in previous section)
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Channel 1 values of power supplies on left side of power rack

Channel 2 values of power supplies on left side of power rack
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Values of power supplies on right side of power rack
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